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Scottish Text Society Editions 
 
The Scottish Text Society was founded in 1882 'for the purpose of Printing and 
Editing Texts illustrative of Scottish Language and Literature', as the series lists at 
the back of each volume used to advertise. Although the Society's reach has in the 
past extended as far as eighteenth-century texts, its focus is on publishing Older 
Scots works (i.e. those written before 1700, the period covered by the Dictionary 
of the Older Scottish Tongue). The Society aims to produce editions that are both 
scholarly and accessible. All editions offer detailed introductions and thorough 
annotation, but the STS is flexible in its requirements for the treatment of texts. In 
rare cases where a text is deemed to be of chiefly linguistic interest and the original 
MS or print is not readily accessible by other means (e.g. EEBO), the edition might 
reproduce the witness as closely as possible, even to including its original 
capitalisation and punctuation. More commonly, a small degree of modernisation 
is implemented to make a text more accessible: for details, see under 'Text' below. 
Modernisation never extends to standardising spelling or altering vocabulary or 
grammar, however; nor are translations provided. 
 
For each edition provisionally contracted for publication, The STS will appoint an 
Editorial Adviser (see below for a description of the Adviser's role). It is the duty 
of editors to remain in contact with their Advisers about the progress of their 
editions, and to submit annual reports to their Advisers and to the Editorial 
Secretary when prompted to do so.  
 
For any aspects not covered by these Guidelines, please refer to Boydell & 
Brewer's House Style Guidelines. 
 
 
ORDERING OF MATERIAL 
 
The recommended ordering of the sections of a single-volume edition is as 
follows: 
 
1. Preliminary pages 

a) Caption for frontispiece (if used) 
b) Title page:  N.B. the STS logo, year of publication and volume number 

will be inserted at copy-editing stage, if the latter two are unknown. The 
main thing here is to set out the title and your name exactly as you wish 
it to appear. 

c) Dedication (if any) 
d) Contents  

N.B. just print '00' for the page numbers of each section, since these 
will not be known until the volume has been typeset. Ensure you 
include a separate section for any illustrations, figures or maps. 

e) Illustrations and Figures (if any) 
f) Foreword/Preface (if any) 
g) Acknowledgements 
h) List of Abbreviations 
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2. Introduction 
3. TEXT(S) 
4. Textual Apparatus (see further below) 
5. Notes (divided into Textual Notes and Explanatory Notes if required) 
6. Appendices 
7. Bibliography 
8. Index of First Lines (if relevant) 
9. Index of Names/Places (two lists or a combined list, as seems appropriate) 
10. Glossary 
 
 
1. vii Abbreviations  
Abbreviations and abbreviated titles of works cited frequently should appear in a 
separate list of abbreviations. You can either give full bibliographic details here, in 
the Bibliography, or both, but they must be given somewhere. The list may 
include:  

• common reference works such as DOST (Dictionary of the Older Scottish 
Tongue), OED (Oxford English Dictionary), ESTC (English Short Title 
Catalogue) 

• other commonly abbreviated resources such as TA (Accounts of the Lord 
High Treasurer of Scotland);  ER (Exchequer Rolls of Scotland) 

• well known and commonly abbreviated journal titles such as SHR (Scottish 
Historical Review) or Scottish Literary Journal (SLJ) 

• series titles such as EETS OS and SS (Early English Text Society, Original 
Series and Supplementary Series), STS (Scottish Text Society) 

• libraries and repositories such as the NLS (National Library of Scotland), 
NRS (National Records of Scotland), BL (British Library) 

• other kinds of abbreviation, e.g. languages OSc (Older Scots), ME (Middle 
English), OE (Old English), OF (Old French) 

• works frequently referred to, e.g. Wyntoun (Andrew of Wyntoun's Original 
Chronicle)  

• frequently cited editions which are listed by title or author's name in the 
Bibliography, but whose editors you may wish to cite directly in your 
discussion, e.g. Laing, Wood, Fox (in this case, editors of the works of 
Henryson) 

 
2. Introduction 
The Introduction should (though not necessarily in this order): 

• Describe the witnesses of the text(s). This should include a detailed 
physical description (size in mm, material, watermarks [if paper], number 
of leaves/pages, discussion of scribal hands or typeface, decoration and 
illustrations, degree of textual completeness). It should cite appropriate 
authorities (e.g. IMEV, (E)STC, Wing) and previous descriptions of 
individual witnesses. It should also evaluate the relative authority of extant 
witnesses, bearing in mind that textual authority is not necessarily dictated 
by age.  
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• Discuss date and authorship (insofar as either can be determined) and the 
early history of the text, with a particular -- though not exclusive -- focus 
on Scottish interest. 

• Describe the language of the text. This may be less important for late texts 
but is desirable for earlier ones, particularly when it has a bearing on dating 
the text. 

• Some verse texts may benefit from a section on verse form, particularly if 
the editor's understanding of it has had a bearing on the treatment of the 
text (e.g. if there has been emendation for the sake of metre or alliteration). 

• Assess the text as a literary and historical production. 
• Describe and comment on any previous editions of the text (in some cases, 

this section might follow on most naturally from discussion of the text's 
early history and dissemination). 

• Give a clear statement of editorial practice, giving details on how the 
witness text has been presented (e.g. handling of such matters as 
punctuation, capitalisation, handling of the witness's distribution of thorn/y, 
yogh/z,  i/j and u/v/w) and how any variants have been indicated for 
multiple witnesses; principles adopted in emendation, etc. 

 
3. Text 

N.B  For more on formatting, see under TYPESCRIPT AND ELECTRONIC 
FILES below. 

• Lines of verse should be left-aligned and separated by hard returns.  
• Lines should be numbered in fives, with line-numbers placed to the right of 

the text (use the Tab key and align the numbers as far to the right of the text 
as practicable). 

• N.B. The layout and line-numbering of prose texts is more complex and will 
need to be discussed with the Editorial Secretary and B&B production 
staff. Likewise texts with marginalia. 

• Folio/page or signature numbers. These should always be included. They 
can be placed either to the left of the column of text (indenting the entire 
text by one tab stop if so) OR to the right, one tab stop further than the line 
numbers. So long as they are clearly marked, their final placement can be 
altered if need be at the copy-editing/typesetting stages. 

• Change of hand in a manuscript witness: it is helpful to mark this with an 
asterisk * at the point of change in the text and add a note in the Textual 
Apparatus identifying it. If there is more than one change of hand on a 
single page, they will need to be differentiated, e.g. *] Hand A stint begins; 
**] Hand B stint begins 

• Abbreviations/suspensions: Silent expansion of abbreviations makes for a 
more readable text and is the standard policy for comparable scholarly text 
societies such as EETS, so silent expansion is the recommended practice 
for all but the most deliberately conservative of STS editions. 

• Letter-forms. Although practice in past STS volumes has varied, Council 
has decided that, given the remit of the STS as a publisher of scholarly 
editions, the default expectation from now on is that editors will RETAIN 
obsolete letter-forms and usages. Thus original MS/print distribution of i/j 
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and u/v/w should be retained, as well as yogh (ȝ). Where a witness fails to 
distinguish between graphs y and þ, however, thorn should be printed 
wherever this is the intended value.  
If an editor feels there is a strong case to be made for diverging from this 
practice, the matter must be discussed beforehand with the Editorial 
Adviser AND Editorial Secretary (the latter on behalf of Council, who may 
be consulted on the matter). The case for such treatment will then need to 
be set out clearly in the section on editorial practice in the Introduction.   

 
 
4. Textual Apparatus 
In most cases, the Textual Apparatus will appear at the foot of the relevant pages in 
the published volume. However, you should present it to B&B as a separate list 
keyed to line-numbers (for poetry: prose texts are a different matter and will 
require individual handling). In an edition of a single text, the Textual Apparatus 
should have its own Word file; for an edition of multiple shorter texts, it may be 
simpler to list lemmata at the end of each poem, marking them 'Textual Apparatus 
for Insertion' on the hard copy. Either way, B&B can be relied upon to position 
them correctly at the typesetting stage. 
 
The Textual Apparatus should signal such things as: 

• scribal emendations (scoring out and insertion by the main or other hands) 
• marginal scribal activity 
• editorial emendations  
• particular print features (e.g. the substituted or reversed letters so useful 

for identifying particular editions, catchwords, paraph marks, decorative 
features etc.) 

• variant readings from other prints or manuscripts:  
In all but conservative editions whose interest is primarily linguistic, 
variants in the apparatus should be restricted to the substantive, i.e. 
different words or phrasings. Spelling variants should normally only be 
noted if they indicate a significant phonemic difference, e.g. stone for 
stane/stain. More detailed discussion of variants may appear in the Notes. 
 

Ensure that the sigils used for all MSS and prints are clearly indicated in the 
Introduction. They may also be included among the 'Abbreviations' listed at the 
front of the volume. If numerous, a separate list may be appended to the 
'Abbreviations'. Manuscripts/prints agreeing with the lemma need not be cited in a 
textual note. Use a consistent order in listing sigils. Try to make the sigils as clear 
as possible. Single letters are best, but where longer sigils are required for 
differentiation, ensure that the second letter is lower-case: e.g. 'Bn' (Bannatyne 
MS); 'Bs' (Bassandyne print). Two capital letters indicates combined witnesses, 
e.g. 'WS' (where 'S' is a paginary reprint of 'W' and both have been consulted). 

Layout: 
line number (single space); lemma from text (left-facing square bracket, single 
space) variant (single space) sigil(s): 
 22 sewit] hewit D 
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Where more than one variant is listed: 
 320 Palicene] Pelicane E, Pellan WS 
 
Where an emendation has been adopted from another witness (here, A is the base 
text): 
 666 gruching] B, gruthing A  

 
Where an emendation has not been adopted from another witness: 

27 ryght] rythgt P verry B 
 

Where there is more than one lemma for a single line of text, separate the notes by 
5 spaces: 
 61  And] Syne WS     watch did keep] took good heed WS 

 
Where the lemma relates to a word that is repeated in that line, use a superscript 
number to indicate which instance is meant: 
 848 þe

2
] to B 

All editorial comment should be in italics and kept to a minimum: 
 244 Buchquhilchanon] i and ch written over now-illegible letters DL 
 215  At] Written with enlarged capital 
 421 the] Om.  (or 'Omitted') 
 

 
5. Notes 
Where there are a great many notes concerning textual matters (e.g. if there are 
multiple witnesses and complex relationships between them), you may wish to 
create a separate set of Textual Notes preceding what should then be labelled the 
Explanatory Notes. If specific Textual Notes are very few, a single combined 
section of Notes will suffice.  
 
Textual Notes deal with such matters as: discussion of more complex scribal 
corrections; interesting features of print or MS; activity by different scribal hands; 
alternative readings; the reasoning behind an editorial emendation, etc. 
 
Explanatory Notes should be as concise as possible. They may offer 
interpretations of obscure words or lines; in relation to the given line(s), they may 
discuss sources, analogues and allusions; historical background, and anything else 
that helps to elucidate the text. They should avoid duplication of material in either 
the Glossary or the Introduction (though they may provide cross-references to the 
Introduction). Quotations from foreign languages, whether ancient or modern, 
should be translated.  
 
Notes should be formatted as follows: 
 (tabbed indent) line number (space) text for commentary (if required) 
(space) Note. 
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 90 birkin ‘beat’ not listed in DOST, but MED records two examples, 
both from northerly texts (Sir Gowther and the Towneley Plays), while 
OED records a rare single instance from 1675.  

 
6. Appendices 
Appendices, where they are required in any edition, will be sui generis in 
character. Content and layout will be a matter for negotiation between the Editor, 
Editorial Adviser and Editorial Secretary. 
 
 
7. Bibliography and References 
The STS prefers the author/date referencing system. References within the 
Introduction or Explanatory Notes should take the form '(Smith 2012)', or '(Smith 
2012, 18)' for a specific page reference. Multiple citations are separated by semi-
colons: (Smith 2012, 18; Kniesza 1997, 35)  
 
It is normally most convenient to divide the Bibliography into Primary and 
Secondary Works. Individual entries should be in this order: 

 
Last name, First name. YEAR. Title in italics. Place of publication: 
Publisher.  

 
E.g. Bawcutt, Priscilla. 1992. Dunbar the Makar. Oxford: Clarendon Press. 
 
But for publications by text societies such as the STS or EETS, no further 
information about the publisher is required: 

Smith, Jeremy J. 2012. Older Scots: A Linguistic Reader. STS 5th series 9. 
Edinburgh. 

For essays within collections: 

Kniezsa, Veronika. 1997. ‘The origins of Scots orthography’. In The 
Edinburgh History of the Scots Language. Ed. Charles Jones. Edinburgh: 
Edinburgh University Press, 24–46. 

Editions are listed by author wherever known: 

Henryson, Robert. 2010. The Complete Works. Ed. David J. Parkinson. 
Kalamazoo: Medieval Institute Publications. 

by title where not: 

Deidis of Armorie, The. 1994. Ed. Luuk Houwen. 2 vols. STS, 4th Series 
22–23. Edinburgh.  

and by editor for a collection of texts published under a modern editorial title: 

Purdie, Rhiannon, ed. 2013. Shorter Scottish Medieval Romances: 
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Florimond of Albany, Sir Colling the Knycht, King Orphius, Roswall and 
Lillian. STS, 5th Series 11. Edinburgh. 

Dissertations: 

Mackay, Margaret Ann. 1975. ‘The Alliterative Tradition in Middle Scots 
Literature’. Unpublished Ph.D. Diss., Edinburgh. 

or, for dissertations available electronically: 

MacGregor, Martin. 1989. ‘A Political History of the MacGregors before 
1571’. Ph.D. Diss., University of Edinburgh. URI: 
http://hdl.handle.net/1842/6887  

 
For authors who have more than one publication in the same year, distinguish them 
with letters: 

Mapstone, Sally. 1999a. ‘Invective as Poetic: The cultural contexts of 
Polwarth and Montgomerie’s Flyting’, Scottish Literary Journal 26, ii, 18–
40.  
—— 1999b. Review of The Works of Geoffrey Chaucer and ‘The Kingis 
Quair’, Review of English Studies 50, 504–5  
 

 
8. Index of First Lines  
This is only relevant for collections of poems whose titles are not listed on the 
Contents page, or whose first lines may be more familiar to some readers than any 
editorial titles assigned.  
 
 
9. Index of Names and Places  
This may be presented as one list or two, depending on quantity. All instances of a 
given name should be cited: this is a finding-guide for readers. All spelling variants 
should be recorded. Translations or explanations may be provided for potentially 
unrecognisable names. Adopt the layout of the Glossary.  
 
E.g. Meledas  Meliades, beloved of Clariodus RL779n  
 Tern(e)way Darnaway Castle, Morayshire 992, 1000 
  
 
 
10. Glossary 
Glossaries in STS volumes are selective, but should serve a reasonably broad 
audience. They should cover obsolete words, usages that differ from modern 
standard English, Scots words (even if their usage remains the same in Modern 
Scots) and those whose spellings may render them unrecognisable. Etymologies 
should not be included. Definitions should be as succinct as possible: try to offer 
the single most appropriate gloss, rather than an indecisive list of synonyms. 
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 The headnote to the Glossary should mention any peculiarities of 
alphabetical ordering, such as treatment of thorn and yogh (if printed) and whether 
vowels i/y have been conflated (recommended for all texts where they are used 
interchangeably). Consonantal i =j should be listed separately from vowel i/y; it is 
likewise helpful to alphabetise u/v/w according to value, i.e. whether it represents 
vowel u, consonant v or semi-vowel w (some cross-referencing may be necessary). 
Thorn should be treated as th and yogh as semi-vowel y or consonant z, as 
appropriate.  
 The most frequent spelling of a word in the text should be used as the 
headword, with cross-references provided for all variants unless adjacent to the 
headword: do not make less experienced readers guess where to find a word, nor 
swell the Glossary with duplicated entries. Do not create artificial headwords that 
do not appear anywhere in the text: e.g. if a noun only occurs in plural form in the 
text, the plural form should be the headword.  
 In choosing a verb's headword, select the infinitive if available, then 
present over past tense forms, singular over plural. Unite all forms of a verb under 
a single headword, providing cross-references as necessary (this can be 
surprisingly time-consuming): 
 
haue, haif, haife v. have KO48 SC162 SC171 FA48; convey KO98; pres.1 sg. 

KO58. hes pres.3 sg. KO6 SC231 FA137 FA155 etc.. haue, have, 
hes pres.pl. SC100 FA10 FA23 FA34 etc. had(e), haid pa.t. KO44 
KO148 SC15 FA475 etc.; brought FA97 

 
Grammatical categories (adopted from EETS Editorial Guidelines): 

acc(usative), adj(ective), adv(erb), anom(alous), card(inal), comp(arative), 
conj(unction), dat(ive), dem(onstrative), gen(itive), imp(erative), impers(onal), 
ind(icative), indecl(inable), inst(rumental), interj(ection), intrans(itive), n(oun), 
nom(inative), num(eral), ord(inal), p(articiple), pa(st), pa. p. = past participle, 
pl(ural), poss(essive), ppl. = participial (e.g. in participial adjective, ppl.adj.), 
pr(esent), pr. p. = present participle, pref(ix), prep(osition), pron(oun), refl(exive), 
rel(ative), sg. = singular, subj(unc- tive), superl(ative), t(ense), trans(itive), v(erb), 
vbl. = verbal (e.g. in vbl.n. 'verbal noun').  

The abbreviation is followed by a full point: v., n., prep. etc.  

The list of grammatical abbreviations should appear at the head of the Glossary. If 
they have been used frequently elsewhere in the volume, e.g. in a discussion of 
language in the Introduction, you may wish to add a note at the end of the 
preliminary Abbreviations list referring readers to the Glossary for grammatical 
abbreviations.  

The recommended order of reference for verbs is:  
Infinitive. Present 1, 2, 3 singular; plural (note there is rarely any need to 
distinguish persons in the plural). Subjunctive singular, plural. Imperative 
singular, plural. Present participle. Past singular (person marked only when 
necessary), plural.  Subjunctive singular, plural. Past participle.   
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For frequently occurring words, cite the first three occurrences followed 'etc.' If, 
however, there are multiple spellings, ensure that an occurrence is cited for each 
spelling. 

Line-numbers of emended words should be asterisked; line-numbers for which 
there is a relevant explanatory note should be followed by 'n' (often, both will 
apply): 
 skrik n. shriek KO42*n 
 
Definitions should be placed next to the examples they gloss, and glossed phrases 
should replace the headword with a tilde: 

biforne adv. ahead of KO39, in front of  SC61. þe streit ~ in the street 
KO90n 

 
 
TYPESCRIPT AND ELECTRONIC FILES 
 
The Council-approved final version of your STS edition (see below under 'Stages 
of Publication') should be submitted to B&B on disk or memory stick and in hard 
copy; the hard copy and files on disk/memory stick must be identical. Editors are 
asked to submit their work as MS Word files. Please label the disk/memory stick 
clearly. Images can be included on the main disk/memory stick or on a separate 
disk. 
 
In a cover note, list ALL files submitted, including illustrations, the strike-out file 
and any pdf guides for the layout of parallel texts (see below). Ensure that the 
separate files are clearly labelled in your hard copy if you will be posting this 
directly to B&B yourself (you may find it convenient to frill the edge of your 
printed manuscript with labelled stickies).   
 
Do not submit the book as an enormous single file (although it can be extremely 
helpful to make an enormous single file of the final draft for yourself, for ease of 
searching and checking). Separate files should be created for: the Preliminary 
Pages; Introduction; Text (divide into separate files if more than one, or if 
extremely long); Textual Apparatus (if not included at the end of the text files); 
Notes (or separate files of Textual and Explanatory Notes); Appendices; 
Bibliography; Index of First Lines; Index of Names/Places; Glossary. Ideally, the 
pages should be numbered consecutively throughout the manuscript except for the 
Preliminary Pages, which should be numbered separately. 
 
Files should be as bare of formatting as possible: do not insert blank pages, use 
special templates or automated styles (other than 'Normal'). The appearance of the 
final published page is the B&B typesetter's responsibility and they will consult 
closely with you in ensuring it is what you want.   
 
Hard copy should be printed out double-spaced and single-sided.  
 
Parallel Texts: It is the typesetter's job to ensure that parallel texts are aligned 
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correctly in the final version, so each text should be supplied as a separate file. 
However, it is very helpful if you can supply a pdf showing how you wish them to 
be aligned, to act as a guide for the typesetter. (For this, you may find it convenient 
to load each text into columns in Word and align as desired before saving the 
whole as a pdf clearly marked FOR REFERENCE ONLY.) 
 
Paragraphs: new paragraphs should be marked by indentation (use the Tab key) 
rather than by leaving a space. 
 
Verse: Lines of verse should be separated by hard returns. 
 
Headings: be consistent in the use of headings and subheadings, and ensure that 
differing levels of heading are clearly marked, e.g. by labelling them 'A', 'B' etc. by 
hand in the margins of the hard copy. 
 
Quotations: quoted material of over 50 words in length (e.g. in the Introduction or 
Notes) should be separated from the main body of the text: indent from the left 
margin and give a line space (i.e. two hard returns) above and below the extract. 
Use tabs rather than the space bar to indent text (or use the 'paragraph indent' 
command for a prose block quotation).  
 
Cross references: Please indicate cross-references to pages with the use of 0, i.e. 
`p.0’ or `p.00’. You should then complete the reference at page-proof stage by 
writing the correct number on the proofs.   
 
Special Characters: Please supply a separate strike-out file -- in hard copy and on 
your disk/memory stick -- of a list of special characters used which do not occur on 
a standard keyboard, e.g. thorn, eth, yogh, diacritical mark, Greek letters etc. (there 
is no need to include the standard accented characters of modern French, German, 
Spanish, Italian, etc.). The list should include the page number of that character's 
first appearance, which it would be helpful to highlight on the hard copy. If you 
have been unable to find þ, ȝ etc. in your version of Word, please indicate how you 
have denoted them on your script. The important thing is to avoid assigning a 
second meaning to an existing character, i.e. do not use numerals '3' for yogh, or '7' 
for '&'. 
 
Software developers seem to delight in hiding the extended character&symbol set 
in a new place for each version, so the advice below will inevitably go out of date 
(or be too recent for users of older versions). Nevertheless, all systems will have a 
version of an extended character&symbol set hidden in them somewhere, so it is 
worth seeking it out. 
 

• For Mac users, thorn, yogh, diacritics and phonetic symbols etc. can all be 
found in Latin menu of the 'Character Palette' or 'Characters', or 
'Emoji&Symbols', depending on the age of the system. From within Word, 
you can click Edit>Emoji&Symbols (in earlier versions, Insert>Symbols) 
then click the tiny 'Characters' symbol in the top right of the window to 
bring up the full 'Characters' menu. (Save any you are likely to want again 
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as 'Favorites'.) To make the Characters/Emoji&Symbols viewer 
permanently accessible from the top right of the menu bar (whether or not 
Word is open), go to System Preferences>Language&Region>Keyboard 
Preferences>Keyboard> and check the box for 'Show Keyboard, Emoji, & 
Symbol Viewers in menu bar'.   

• Users of Windows 10 will find the Character Map from Start>Windows 
Accessories>Character Map.  

• Users of some earlier versions of Windows will find it from Start>All 
Programs>Accessories >System Tools>Character map. 

 
 
Illustrations and Figures 
Although illustrations are not required for STS editions, a frontispiece is a 
desirable addition, and there may be other peculiarities of a witness's appearance or 
codicological make-up which it would be helpful to illustrate. You may also wish 
to present some information in tabular or diagrammatic form. All prospective 
illustrations should be discussed beforehand with the Editorial Adviser and 
Editorial Secretary.  
 Illustrations -- whether images or diagrams and tables -- should be supplied 
at the same time as the final manuscript as separate files: do not embed them in 
your Word files. It is the Editor's responsibility to order or commission them and to 
obtain any necessary permissions, although the STS will reimburse the associated 
costs. Indicate on the hard copy where you wish any illustrations other than a 
frontispiece to appear. You may also insert a placeholder in the electronic copy, 
e.g. '[INSERT FIGURE 1 HERE]', but be sure to check that this note has been 
removed at proof stage. If you want to show only part of a photograph supplied, 
please indicate on a separate photocopy of it what should be omitted.  

Photographs may be supplied as glossy prints, transparencies, or electronically, 
scanned to no less than 300 dpi at a size of at least 12cm by 18cm. If an electronic 
image supplied is to be cropped, the cropped section must have a resolution of 300 
dpi with these measurements. Electronic images should be supplied as TIFF files. 
B&B require a print-out in the case of transparencies and electronic images.  

Tables and Graphs with a complicated layout should be sent as samples in 
advance for checking by B&B production staff; this is particularly the case with 
genealogical tables (B&B can tidy up a slightly amateurish-looking genealogical 
table drawn up in Word, for example). Consult with the Editorial Secretary in the 
first instance if you are unsure of the best way to present such material. 

Please ensure that you have obtained permission for all illustrations where 
necessary, and see that any acknowledgements have been made. Please check 
carefully to see that you have used the exact wording in the credit line as 
specified by the relevant institution. In the case of both illustrations and text, you 
should ask for world English-language rights when seeking permission. Please 
send photocopies of the letters and any statements defining conditions of use to the 
Editorial Secretary; retain the originals for your files. B&B can supply a template 
letter for use in seeking permissions if desired.  
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STAGES OF PUBLICATION 
 
STS editions are published by Boydell & Brewer on behalf of the STS (this is why 
our official place of publication remains Edinburgh, rather than Woodbridge). The 
authority to approve a manuscript, and the responsibility to ensure its quality, thus 
lies with STS Council. 
 
I Submission to the STS 
 

1. The editor submits the final draft in electronic form (unless other 
arrangements are agreed) to the Editorial Adviser, who will read it through 
and draw up a brief report (see 'The Editorial Adviser's Role' below). If any 
adjustments are recommended at this stage, they should be discussed with 
the editor, taking care to keep the Editorial Secretary informed, and the 
editor will submit a revised draft. The Adviser will submit their final report 
to the Editorial Secretary, who receives it on behalf of Council. 

 
2. The editor submits the final draft of the edition (revised if necessary) in 

electronic form to the Editorial Secretary. This should include all ancillary 
illustrations, and be accompanied by any relevant letters of permission. 

 
3. The draft plus the Adviser's report will be forwarded by the Editorial 

Secretary to a reader appointed by Council, who will prepare a more 
detailed report for Council (see 'Reader's Report' below). It is not expected 
that a draft that has reached this stage will be rejected, but further 
alterations may be requested by the reader before publication can be 
recommended to Council.  

 
4. At this stage the Editorial Secretary also reads the draft for points of style, 

presentation and general confirmation to requirements (ensuring that, for 
example, the editor has obtained appropriate permissions for images).  

 
5. The reader's report is circulated around Council for approval.  

 
6. A summary of the approved reader's report is communicated to the editor 

by the Editorial Secretary (allowing the reader to remain anonymous). If 
the report contains any recommendations for revision, a revised draft of the 
edition should be submitted to the Editorial Secretary for confirmation (by 
the reader) that these recommendations have been adequately addressed.  

 
7. The Editorial Secretary will notify B&B that the manuscript is ready for 

submission.  
 

8. At this point, the editor can EITHER submit to B&B directly (the Editorial 
Secretary will confirm details of where and to whom to send it) or -- if the 
editor foresees difficulties in sending hard copy -- all material can be sent 
electronically to the Editorial Secretary, who will arrange for the printing of 
hard copy and submission to B&B. Either way, B&B should receive the 
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complete edition (including hard copy, disk/memory stick and all 
illustrations) from a single person, rather than having it arrive piecemeal 
from different sources, risking the displacement or loss of some elements. 

 
 
II Submission to Boydell & Brewer 
 

From this point, you will be in direct communication with staff at B&B and the 
stages of production will be as set out in their standard Author Guidelines, to 
which you are referred for more detail. B&B normally allow 10-11 months 
from receipt of the final manuscript to finished book, although STS editions are 
often turned around slightly faster than this. 

  
1. The manuscript goes to a free-lance copy-editor, who will communicate 

directly with you about major copy-editorial queries (cc'd to the STS 
Editorial Secretary, who can advise if you are uncertain how to resolve 
them). Minor queries may be left until page-proof stage. B&B normally 
expect this phase to be complete within 3 months. 

2. The manuscript goes to type-setting. B&B advise that this can take 
anywhere between 3 weeks and 2 months, depending on complexity. They 
will try to keep you informed of progress so you can plan for the arrival of 
the proofs.  

3. You are sent hard-copy proofs for checking, accompanied by the hard copy 
of your original manuscript (which may be marked up with copy-editing 
queries). Ideally the proofs should be turned around in 3-4 weeks.  

4. You will be sent a proof of the book's label for checking. 
5. The volume is sent to the printer and binder. 

  
 
The Editorial Adviser's Role 
 
Editorial Advisers will normally be members of the STS Council and will have 
particular expertise relevant to the text being edited, whether generic (e.g. political 
poetry) or periodic (e.g. late sixteenth century). On occasion it may be necessary to 
appoint an Adviser from outwith Council's membership. The Adviser is a first 
source of counsel for the editor. They should be able to advise on textual and 
contextual issues, and to have an opinion on the best way to present and explicate 
the text within the Society’s published Editorial Guidelines. They should be 
willing to read samples of texts, notes and other material. Where questions 
concerning presentation and format are not adequately addressed by the Editorial 
Guidelines, they should ensure that the Editorial Secretary is consulted, since the 
latter has responsibility for ensuring a measure of consistency across the Society's 
editions. Decisions or recommendations made by Council regarding the edition 
will normally be communicated to editor and Adviser by the Editorial Secretary: 
Advisers should endeavor to ensure that such recommendations are implemented.  
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It is a requirement that, at some point during the production of an edition, the 
Adviser check the accuracy of a sample of transcribed text against the original 
(whether the actual original or a reasonable reproduction of it).   
 
Annual Reports: When the Editorial Secretary requests an annual report from the 
editor, it should go in the first instance to the Adviser so that s/he has the 
opportunity to add any comments or glossing s/he feels may be required. The 
Editorial Secretary will present the combined reports, redacted if necessary, to 
Council as part of the annual Editorial Secretary's report. (The annual editors' 
reports should be requested at least month before the relevant Council meeting to 
give editors and Advisers sufficient time to complete them.)  
 
Final Report: The final draft of the edition will be sent to the Adviser in the first 
instance. The Adviser is expected to read the full draft and prepare a brief report on 
it for Council (see under 'Stages of Publication'). This should comment on its 
overall suitability for publication, and should also confirm that the Adviser has -- 
now or at some earlier point in the editing process -- checked a sample of the text 
against the original witness(es) for accuracy of transcription. It may (but need not) 
recommend further changes to the edition before it is submitted to Council: again, 
see under 'Stages of Publication' above.  
 
 
 
The Editorial Secretary's Role 
 
The Editorial Secretary is responsible for the administration of all matters directly 
relating to the production and publication of STS editions. This includes preparing 
an annual report for Council containing individual reports on all editions in active 
preparation, and maintaining an archive of editors', advisers' and readers' reports. 
S/he is responsible for updating the STS Editorial Guidelines where deemed 
necessary by Council, and ensuring that all editors and advisers are informed if 
revised Guidelines have been issued. 
 
The Editorial Secretary is responsible for maintaining a level of consistency across 
the Society's editions: this means that s/he should be party to any correspondence 
between editors and Advisers on matters of style, presentation, and general 
approach. S/he will liaise between editors and the publishers where necessary. S/he 
will consult with Council in finding an appropriate reader for the final draft of an 
edition; pass the draft and its Adviser's report to the reader when these come in; 
relay the substance of the reader's report back to the editor (this allows the reader 
to maintain anonymity). S/he will also read through the final draft of an edition, 
although chiefly for points of style and presentation. Once publication has been 
formally recommended to Council by the reader, s/he will liaise with the editor 
over submission of the typescript to Boydell & Brewer: see under 'Stages of 
Publication' above.  
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Reader's Report 
 
Before the STS can approve an edition for publication, it requires a report from an 
independent, anonymised reader appointed by Council. The reader should be 
someone with relevant expertise who has not been involved in work on the edition, 
nor be so close to the editor as to impede impartiality. S/he will normally be a 
member of Council, but it may be necessary on occasion to appoint a reader not 
currently on Council. The report should be reasonably detailed, commenting on all 
major sections of the edition as outlined in the Editorial Guidelines. It should make 
clear whether it recommends publication as is, or if further changes are advised. 
Where changes have been advised, the reader will see the resubmitted draft in 
order to confirm to Council whether or not the recommendations have been 
adequately addressed.  
 
 
 
 
 
Rhiannon Purdie 
November 2016  


